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Preface

This User Guide has been implemented by Boot & Work, S.L. working

under the name Industrial Shields.

Purpose of the manual

The information contained in this manual can be used as a reference to operating, to
functions, and to the technical data of the signal modules, power supply modules and
interface modules.

Intended Audience

This User Guide is intended for the following audience:

● Persons in charge of introducing automation devices.

● Persons who design automation systems.

● Persons who install or connect automation devices.

● Persons who manage working automation installation.

Warnings:

● Unused pins should not be connected. Ignoring the directive may damage the

controller.

● Improper use of this product may severely damage the controller.

● Refer to the controller’s User Guide regarding wiring considerations.

● Before using this product, it is the responsibility of the user to read the product’s User

Guide and all accompanying documentation.

● Maintenance must be performed by qualified personnel familiarised with the

construction, operation, and hazards involved with the control.

● Maintenance should be performed with the control out of operation and disconnected

from all sources of power.

● Care should be taken when servicing electrostatic sensitive components. The

manufacturer's recommendations for these components should be followed.
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● The M-Duino GPRS Family PLCs are Open Type Controllers. It is required that you install

the M-Duino GPRS PLC in a housing, cabinet, or electric control room. Entry to the

housing, cabinet, or electric control room should be limited to authorised personnel.

Failure to follow these installation requirements could result in severe personal injury

and/or property damage. Always follow these requirements when installing M-Duino

family PLCs.

● In case of installation or maintenance of the M-Duino please follow the instructions

marked in the Installation and Maintenance section.

● Do not disconnect equipment when a flammable or combustible atmosphere is

present. Disconnection of equipment when a flammable or combustible atmosphere is

present may cause a fire or explosion which could result in death, serious injury and/or

property damage.

Avertissements:

● Les broches non utilisées ne doivent pas être connectées. Ignorer la directive peut

endommager le contrôleur.

● Une utilisation incorrecte de ce produit peut endommager gravement le contrôleur.

● Reportez-vous au Guide de l’utilisateur du contrôleur pour les considérations de

câblage.

● Avant d’utiliser ce produit, il incombe à l’utilisateur de lire le Guide de l’utilisateur du

produit et la documentation qui l’accompagne.

● La maintenance doit être effectuée par personnel qualifié familiarisé avec la

fabrication, le fonctionnement et les dangers liés au contrôleur.

● La maintenance doit être effectuée avec l’équipement hors service et déconnectée de

toutes les sources d'alimentation.

● Faites attention lors de l'entretien des composants sensibles à l'électricité statique. Les

recommandations du fabricant pour ces composants doivent être suivies.

● Les automates de la famille M-Duino sont des contrôleurs de type ouvert. Il est

nécessaire d'installer l'automate M-Duino dans un boîtier, une armoire ou une salle de

contrôle électrique. L'accès au boîtier, à l'armoire ou à la salle de commande

électrique doit être limité au personnel autorisé. Le non-respect de ces exigences

d'installation peut entraîner des blessures graves et/ou des dommages matériels

importants. Respectez toujours ces exigences lors de l'installation des automates de la

famille M-Duino.

● En cas d'installation ou de maintenance du M-Duino, veuillez suivre les instructions

indiquées dans la section Installation et Maintenance.

● Ne débranchez pas l'équipement en présence d'une atmosphère inflammable ou

combustible. La déconnexion de l'équipement en présence d'une atmosphère

inflammable ou combustible peut provoquer un incendie ou une explosion pouvant

entraîner la mort, des blessures graves et/ou des dommages matériels.
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Application Considerations and Warranty

Read and understand this manual

Please read and understand this manual before using the product. Please consult your

comments or questions to Industrial Shields before using the product.

Application Consideration

THE PRODUCTS CONTAINED IN THIS DOCUMENT ARE NOT SAFETY RATED. THEY SHOULD NOT

BE RELIED UPON AS A SAFETY COMPONENT OR PROTECTIVE DEVICE FOR ENSURING SAFETY OF

PERSONS, AS THEY ARE NOT RATED OR DESIGNED FOR SUCH PURPOSES.

Please know and observe all prohibitions of use applicable to the products.

FOR AN APPLICATION INVOLVING SERIOUS RISK TO LIFE OR PROPERTY WITHOUT ENSURING

THAT THE SYSTEM AS A WHOLE HAS BEEN DESIGNED TO ADDRESS THE RISKS, NEVER USE THE

INDUSTRIAL SHIELDS PRODUCTS.

NEVER USE THE INDUSTRIAL SHIELDS PRODUCTS BEFORE THEY ARE PROPERLY RATED AND

INSTALLED FOR THE INTENDED USE WITHIN THE OVERALL EQUIPMENT OR SYSTEM.

Industrial Shields shall not be responsible for conformity with any codes, regulations or

standards that apply to the combination of products in the customer’s application or use of the

product.

The following are some examples of applications for which particular attention must be given.

This is not intended to be an exhaustive list of all possible uses of the products, nor is it

intended to imply that the uses may be suitable for the products:

● Systems, machines, and equipment that could present a risk to life or property.

● Nuclear energy control systems, combustion systems, railroad systems, aviation

systems, medical equipment, amusement machines, vehicles, safety equipment, and

installation subject to separate industry or government regulations.

● Outdoor use, uses involving potential chemical contamination or electrical

interference, or conditions or uses not described in this document.

At the customer’s request, INDUSTRIAL SHIELDS will provide applicable third party certification

documents identifying ratings and limitations of use that apply to the products. This

information by itself is not sufficient for a complete determination of the suitability of the

products in combination with the system, machine, end product, or other application or use.
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Intended use of Industrial Shields products

Consider the following:

Industrial Shields products should only be used for the cases of application foreseen in the

catalogue and the associated technical documentation. If third-party products and components

are used, they must have been recommended or approved by Industrial Shields.

The correct and safe operation of the products requires that your transport, storage,

installation, assembly, operation and maintenance have been carried out in a correct manner. It

must respect the permissible ambient conditions. You should also follow the indications and

warnings that appear in the associated documentation.

The product / system dealt with in this documentation should only be handled or manipulated

by qualified personnel for the task entrusted and observing what is indicated in the

documentation corresponding to it, particularly the safety instructions and warnings included

in it. Due to their training and experience, qualified personnel are in a position to recognize

risks resulting from the handling or manipulation of such products / systems and to avoid

possible hazards.

Disclaimers

Weights and Dimensions

Dimensions and weights are nominal and they are not used for manufacturing purposes, even

when tolerances are shown.

Performance Data

The performance data given in this manual is provided as a guide for the user in determining

suitability and does not constitute a warranty. It may represent the result of INDUSTRIAL

SHIELDS’s test conditions, and the users most correlate it to actual application requirements.

Actual performance is subject to the INDUSTRIAL SHIELDS Warranty and Limitations of Liability.
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Errors and Omissions

The information in this document has been carefully checked and is believed to be accurate;

however, no responsibility is assumed for clerical, typographical, or proofreading errors, or

omissions.

Residual Risks

The control and drive components of an Industrial Shields PLC are approved for industrial and

commercial use in industrial line supplies. Their use in public line supplies requires a different

configuration and/or additional measures. These components may only be operated in closed

housings or in higher-level control cabinets with protective covers that are closed, and when all

of the protective devices are used. These components may only be handled by qualified and

trained technical personnel who are knowledgeable and observe all of the safety information

and instructions on the components and in the associated technical user documentation.

When carrying out a risk assessment of a machine in accordance with the EU Machinery

Directive, the machine manufacturer must consider the following residual risks associated with

the control and drive components of a PDS.

1. Unintentional movements of driven machine components during commissioning, operation,

maintenance, and repairs caused by, for example: − Hardware defects and/or software errors in

the sensors, controllers, actuators, and connection technology − Response times of the

controller and drive − Operating and/or ambient conditions not within the scope of the

specification − Condensation / conductive contamination − Parameterization, programming,

cabling, and installation errors − Use of radio devices / cellular phones in the immediate

vicinity of the controller − External influences / damage.

2. Exceptional temperatures as well as emissions of noise, particles, or gas caused by, for

example: − Component malfunctions − Software errors − Operating and/or ambient

conditions not within the scope of the specification − External influences / damage.

3. Hazardous shock voltages caused by, for example: − Component malfunctions − Influence of

electrostatic charging − Induction of voltages in moving motors − Operating and/or ambient

conditions not within the scope of the specification − Condensation / conductive

contamination − External influences / damage

4. Electrical, magnetic and electromagnetic fields generated in operation that can pose a risk to

people with a pacemaker, implants or metal replacement joints, etc. if they are too close.

5. Release of environmental pollutants or emissions as a result of improper operation of the

system and/or failure to dispose of components safely and correctly.
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Warranty and Limitations of Liability

Warranty

Industrial Shields’s exclusive warranty is that the products are free from defects in materials

and workmanship for a period of one year (or other period if specified) from date of sale by

Industrial Shields.

INDUSTRIAL SHIELDS MAKES NO REPRESENTATION OR WARRANTY, EXPRESSED OR IMPLIED,

REGARDING MERCHANTABILITY, NON-INFRINGEMENT, OR FITNESS FOR PARTICULAR PURPOSE

OF THE PRODUCTS. ANY BUYER OR USER ACKNOWLEDGES THAT THE BUYER OR USER ALONE

HAS DETERMINED THAT THE PRODUCTS WILL SUITABLY MEET THE REQUIREMENTS OF THEIR

INTENDED USE. INDUSTRIAL SHIELDS DISCLAIMS ALL OTHER WARRANTIES, EXPRESS OR

IMPLIED

Limitations of Liability

INDUSTRIAL SHIELDS SHALL NOT BE RESPONSIBLE FOR SPECIAL, INDIRECT, OR CONSEQUENTIAL

DAMAGES, LOSS OF PROFITS OR COMERCIAL LOSS IN ANY WAY CONNECTED WITH THE

PRODUCTS, WHETHER SUCH CLAIM IS BASED ON CONTRACT, WARRANTY, NEGLIGENCE, OR

STRICT LIABILITY.

IN NO EVENT SHALL INDUSTRIAL SHIELDS BE RESPONSIBLE FOR WARRANTY, REPAIR OR OTHER

CLAIMS REGARDING THE PRODUCTS UNLESS INDUSTRIAL SHIELDS’S ANALYSIS CONFIRMS THAT

THE PRODUCTS WERE PROPERLY HANDLED, STORED, INSTALLED, AND MAINTAINED AND NOT

SUBJECT TO CONTAMINATION, ABUSE, MISUSE, OR INAPPROPRIATE MODIFICATION OR REPAIR.

ETL Listing Mark-Direct Imprint information

Recognized
Component ETL Classified

Conforms to:
UL Std. 61010-1
UL Std. 61010-2-201
Cert. To CSA Std. C22.2 No. 61010-1
Cert. ToCSA Std. C22.2 No.61010-2-201

Place for control
number:
5016476
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1 General Description M-DUINO GPRS product

1.1 Zone - Nomenclature

The nomenclature shown in this point will be used in the whole User Guide, so it is important

to understand this nomenclature.

The nomenclature to differentiate the zones is based on the Alphabet, being A the shield from

below and D the shield from above. Having a B and a C in the middle of them.:

● The inputs in the zone B are named I0.X, being X any number suitable in the Shield.
Outputs are named as Q0.X and relays as R0.X

● The inputs in the zone C are named I1.X, being X any number suitable in the Shield.
Outputs are named as Q1.X and relays as R1.X

● The inputs in the zone D are named I2.X, being X any number suitable in the Shield.
Outputs are named as Q2.X and relays as R2.X
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1.2 Reference table

Reference Table

Model Reference

PLC M-Duino General Family

M-DUINO PLC Arduino Ethernet & GPRS 19R I/Os Relay / Analog / Digital PLUS 006001000100

M-DUINO PLC Arduino Ethernet & GPRS 21 I/Os Analog/Digital PLUS 006001000200

M-DUINO PLC Arduino Ethernet & GPRS 38AR I/Os Relay / Analog / Digital PLUS 006001000700

M-DUINO PLC Arduino Ethernet & GPRS 38R I/Os Relay / Analog / Digital PLUS 006001000300

M-DUINO PLC Arduino Ethernet & GPRS 42 I/Os Analog/Digital PLUS 006001000400

M-DUINO PLC Arduino Ethernet & GPRS 50RRA I/Os Relay / Analog / Digital PLUS 006001000900

M-DUINO PLC Arduino Ethernet & GPRS 53ARR I/Os Relay / Analog / Digital PLUS 006001001000

M-DUINO PLC Arduino Ethernet & GPRS 54ARA I/Os Relay / Analog / Digital PLUS 006001001100

M-DUINO PLC Arduino Ethernet & GPRS 57AAR I/Os Relay / Analog / Digital PLUS 006001000800

M-DUINO PLC Arduino Ethernet & GPRS 57R I/Os Relay / Analog / Digital PLUS 006001000500

M-DUINO PLC Arduino Ethernet & GPRS 58 I/Os Analog/Digital PLUS 006001000600

To find the reference of your M-Duino GPRS PLC, check the arrow in the picture below. In the

example, the reference is:
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1.3 Zones Table

Zones Table

Model Zone A Zone B Zone C Zone D

M-Duino GPRS PLC 19R+ ✔ Relay - -

M-Duino GPRS PLC 21+ ✔ Analog / Digital - -

M-Duino GPRS PLC 38AR+ ✔ Analog / Digital Relay -

M-Duino GPRS PLC 38R+ ✔ Relay Relay -

M-Duino GPRS PLC 42+ ✔ Analog / Digital Analog / Digital -

M-Duino GPRS PLC 50RRA+ ✔ Relay Relay Analog / Digital

M-Duino GPRS PLC 53ARR+ ✔ Analog / Digital Relay Relay

M-Duino GPRS PLC 54ARA+ ✔ Analog / Digital Relay Analog / Digital

M-Duino GPRS PLC 57AAR+ ✔ Analog / Digital Analog / Digital Relay

M-Duino GPRS PLC 57R+ ✔ Relay Relay Relay

M-Duino GPRS PLC 58+ ✔ Analog / Digital Analog / Digital Analog / Digital

The distribution of the different features that provide the M-Duino GPRS PLC Family is the

following one:

Shield B Zone C Zone D Zone

Analog Shield

12 Inputs
(12 Digital Inputs, 6
of which can work as

Analog Input)

8 Outputs
(8 Digital Outputs, 3
of which can work as

Analog Output)

11 Inputs
(11 Digital Inputs, 6
of which can work as

Analog Input)

8 Outputs
(8 Digital Outputs, 3
of which can work as

Analog Output)

10 Inputs
(10 Digital Inputs, 4
of which can work as

Analog Input)

6 Outputs
(6 Digital Outputs, 2
of which can work as

Analog Outputs)

Relay Shield

5 inputs
(5 Digital Inputs, 4 of
which can work as

Analog Input)

3 Outputs
(3 Digital Outputs, 3
of which can work as

Analog Output)

8 Relays

5inputs
(5 Digital Inputs, 4 of
which can work as

Analog Input)

3 Outputs
(3 Digital Outputs, 3
of which can work as

Analog Output)

8 Relays

6 inputs
(6 Digital Inputs, 4 of
which can work as

Analog Input)

2 Outputs
(2 Digital Outputs, 2
of which can work as

Analog Output)

7 Relays
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1.4 A Zone Features

Shield A Zone

Communication

Shield

(1x) Ethernet

(1x) USB

(1x) I2C

(1x) TTL

(1x) RS-232

(1x) HALF/FULL Duplex RS-485

(1x) SPI external Port

(1x) RTC

(1x) uSD Socket

(1x) GPRS/GSM

1.5 Mechanical dimensions and weights

Measures Table

Model Height (mm) Width (mm) Depth (mm) Max weight (g)

M-Duino GPRS PLC 19R+ 119.5 70.1 101 394

M-Duino GPRS PLC 21+ 119.5 70.1 101 394

M-Duino GPRS PLC 38AR+ 119.5 94.7 101 504

M-Duino GPRS PLC 38R+ 119.5 94.7 101 504

M-Duino GPRS PLC 42+ 119.5 94.7 101 504

M-Duino GPRS PLC 50RRA+ 119.5 119.3 101 614

M-Duino GPRS PLC 53ARR+ 119.5 119.3 101 614

M-Duino GPRS PLC 54ARA+ 119.5 119.3 101 614

M-Duino GPRS PLC 57AAR+ 119.5 119.3 101 614

M-Duino GPRS PLC 57R+ 119.5 119.3 101 614

M-Duino GPRS PLC 58+ 119.5 119.3 101 614
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1.6 General Features

CONNECTABLE PLC ARDUINO 24Vcc M-DUINO

MODEL TYPE Controller General Specifications Information

Input Voltage
12 to 24Vdc

Fuse protection (2.5A)
Polarity protection

Input rated voltage
24Vdc

Rated Power 30 W

I max. 1.5A

Size Check size and weight table

Clock Speed 16MHz

Flash Memory 256KB of which 8KB used by bootloader

SRAM 8KB

EEPROM 4KB

Communications
I2C – Ethernet Port – USB – RS485 – RS232 – SPI – (3x)

RX, TX (Arduino pins)
Max232-Max485-W5500 -

Sim800L

USB consideration!
Only meant for uploading or debugging, not always

connected as a serial in a project!
Cannot be working in a final

application

An/Dig Input 10bit
(0-10Vcc)

0 to 10Vdc
Input Impedance: 39K
Separated PCB ground
Rated Voltage: 10Vdc

5 to 24Vdc
I min: 2 to 12mA
Galvanic Isolation

Rated Voltage: 24Vdc

Max read time: 116us

*Check Section 14 for digital
inputs threshold detection

Digital Isolated Input
(24Vcc)

5 to 24Vdc
I min: 2 to 12mA
Galvanic Isolation

Rated Voltage: 24Vdc

All Digital Inputs are PNP.
Click here1 for more information.

Max read time: 8us

* Interrupt isolated
Input HS (24Vcc)

5 to 24Vdc
I min: 2 to 12mA
Galvanic Isolation

Rated Voltage: 24Vdc
Max read time: 8us

Analog Output 8bit
(0-10Vcc)

0 to 10Vdc
I max: 20mA

Separated PCB ground
Rated Voltage: 10Vdc

Output frequency: 2Hz

Rising edge time: 150ms
Falling edge time: 252ms

Digital Isolated Output
(24Vcc)

5 to 24Vdc
I max: 70mA

Galvanic Isolation
Diode Protected for Relay

Rated Voltage: 24Vdc

Imax 24Vdc: 410mA

With 70 us delay,
freq is 6.849MHz

with pulse width of 106us

Rising edge time: 476ns
Falling edge time: 42.8us

1 https://www.industrialshields.com/blog/arduino-industrial-1/post/pnp-digital-inputs-on-industrial-plc-193
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Digital Isolated Output
Relay

30Vdc / 250Vac
Galvanic Isolation

Diode protected for Relay
Imax: 3A (30Vdc)
Imax: 5A (250Vac)

PWM Isolated Output
8bit (24Vcc)

5 to 24Vdc
I max: 70mA

Galvanic Isolation
Diode Protected for Relay

Rated Voltage: 24Vdc

Direct Arduino Pin
Output

0 to 5Vdc
I max: 40mA

Rated Voltage: 5Vdc

Max frequency: 77kHz

Rising edge time: 200ns
Falling edge time: 200ns

Direct Arduino Pin
Input

0 to 5Vdc
I max: 40mA

Rated Voltage: 5Vdc
Max read time: 8us

I2C Pin
5V Pull-up

Max frequency: 100kHz
Rising edge time: 10us
Falling edge time: 150ns

One-Wire Pin
Usable pins:

Pin3, SCL, SDA, RX0, TX0,
MISO, MOSI, SCK

Frequency: 800kHz

Expandability I2C - 127 elements - Serial Port RS232/RS485

* By using this type of signal can no longer use Digital signal (24Vdc)
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1.7 Power consumption of the M-Duino LoRa Family PLCs

Model Current resting
(mA)

Power resting
(W)

Current active
(mA)

Power active
(W)

21+ 99 2,376 120 2,88

42+ 92 2,208 128 3,072

58+ 76 1,824 126 3,024

19R+ 80 1,92 202 4,848

38R+ 77 1,848 313 7,512

57R+ 73 1,752 425 10,2

38AR+ 72 1,728 221 5,304

53ARR+ 71 1,704 323 7,752

57AAR+ 71 1,704 221 5,304

54ARA+ 76 1,824 231 5,544

50RRA+ 82 1,968 322 7,728

The power consumption is measured at 24Vdc.

The current resting column denotes the minimum current drawn by the PLC when all outputs
are at a LOW level, representing the PLC's baseline power consumption.

In contrast, the current active column reflects the current drawn by the PLC when all outputs
are at a HIGH level, and there are no connections to any of the outputs. While this value is not
the absolute maximum the Arduino based PLC can draw, it serves as a reference point for
expected current values.

It's important to note that the practical maximum current may vary depending on the type of
actuators connected to the outputs and the number of I/Os used. The actual consumption can
be influenced by the specific configuration and load connected to the PLC's outputs."
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2 Technical Specifications

2.1 General Specifications

Item M-Duino GPRS Family PLC

Power supply
voltage

DC power supply 12 to 24Vdc

Operating
voltage range

DC power supply 11.4 to 25.4Vdc

Power
consumption

DC power supply 30W max.

External power
supply

Power supply
voltage

24Vdc

Power supply
output capacity

700mA

Insulation resistance 20MΩmin.at 500Vdc between the AC terminals and the protective earth terminal.

Dielectric strength
2.300Vac at 50/60 Hz for one minute with a leakage current of 10mA max. Between all the external

AC terminals and the protective ground terminal.

Shock resistance 80m/s2 in the X, Y and Z direction 2 times each.

Ambient temperature (operating) 0º to 60ºC

Ambient humidity (operating) 10% to 90% (no condensation)

Ambient environment (operating) With no corrosive gas

Ambient temperature (storage) -20º to 60ºC

Power supply holding time 2ms min.

Weight Check size and weight table

2.2 Performance Specification

Arduino Board ARDUINO MEGA 2560

Control method Stored program method

I/O control method Combination of the cyclic scan and immediate refresh processing methods.

Programming language
Arduino IDE. Based on wiring (Wiring is an Open Source electronics platform composed of a

programming language. “similar to the C”. http://arduino.cc/en/Tutorial/HomePage

Microcontroller ATmega2560

Flash Memory 256KB of which 8KB are used by the bootloader

Program capacity (SRAM) 8KB

EEPROM 4KB

Clock Speed 16MHz
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2.3 Symbology

Table that includes all the symbology that is used in the serigraph of the M-Duino GPRS PLC

Family:

Symbol Standard No. /
Standard Title

Standard
Reference No. /
Symbol Title

Symbol Meaning

IEC 60417 /
Graphical symbols

for use on
equipment

5031 / Direct
Current

Indicates that the equipment is
suitable for direct current only;
to identify relevant terminals

IEC 60417 /
Graphical symbols

for use on
equipment

5032 / Alternating
Current

Indicates that the equipment is
suitable for alternating current

only; to identify relevant
terminals

IEC 60417 /
Graphical symbols

for use on
equipment

5130 / Pulse
General

To identify the control by which
a pulse is started.

IEC 60417 /
Graphical symbols

for use on
equipment

5017 / Earth,
Ground

To identify an earth (ground)
terminal in cases where

neither the symbol 5018 nor
5019 is explicitly required.

IEC 60417 /
Graphical symbols

for use on
equipment

5115 / Signal lamp

To identify the switch by
means of which the signal

lamp(s) is (are) switched on or
off.

2004/108/EC /
Electromagnetic
Compatibility

CE Marking

CE marking indicates that a
product complies with

applicable European Union
regulations

ISO 7000/
Graphical symbols

for use on
equipment

0434B /
Warning symbol

Indicates a potentially
hazardous situation which, if
not avoided, could result in
death or serious injury

ISO 7000/
Graphical symbols

for use on
equipment

5036 / Dangerous
Voltage

To indicate hazards arising
from dangerous voltages
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3 Precautions

Read this manual before attempting to use any of the M-Duino GPRS PLC Family and follow its
descriptions for reference during operation.

3.1 Arduino Board

The M-Duino GPRS Family PLCs include Arduino Mega Board as controller.

3.2 Intended Audience

This manual is intended for technicians, which must have knowledge on electrical systems.

3.3 General Precautions

The user must operate an M-Duino according to the performance specifications described in

this manual. Before using M-Duino under different conditions from what has been specified in

this manual or integrating M-Duino to nuclear control systems, railroad systems, aviation

systems, vehicles, combustion systems, medical equipment, amusement machines, safety

equipment and other systems, machines, and equipment that may have a serious influence on

lives and property if used improperly, consult your INDUSTRIAL SHIELDS representative. Ensure

that the rating and performance characteristics of M-Duino are sufficient for the systems,

machines, and equipment, and be sure to provide the systems, machines, and equipment

double safety mechanisms. This manual provides information for programming and operating

the M-Duino.

3.4 Isolation Precautions

Description:

This equipment does not include galvanic isolation between the grounds of the different

systems. This means that if an external device or sensor that shares the same ground reference

(GND) with the system is connected, any potential difference between these grounds could

damage the connected components. To avoid issues with interference, ground loops, or

damage to external equipment, ensure that all connected devices share the same ground

reference or use systems with appropriate isolation.

Recommendations:

● Connection Review: Verify that all ground connections are properly made and that

there are no significant potential differences between them.

● Use of Isolation: Consider using galvanic isolators or isolation transformers if it is

necessary to connect equipment with different ground references.
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4 M-Duino Pinout

IOs Table

Model Reference

Analog

Input*¹

Digital Isolated

Input

Digital Isolated

Output

Digital/Analog

Output

Relay

Output

PWM Isolated

output*²

19R+ 006001000100 4 1 0 3 8 3

21+ 006001000200 6 6 5 3 0 3

38AR+ 006001000700 10 6 5 6 8 6

38R+ 006001000300 8 1 0 6 16 6

42+ 006001000400 12 11 10 6 0 6

50RRA+ 006001000900 12 7 4 8 16 8

53ARR+ 006001001000 14 8 5 8 15 8

54ARA+ 006001001100 14 12 9 8 8 8

57AAR+ 006001000800 16 13 10 8 7 8

57R+ 006001000500 12 3 0 8 23 8

58+ 006001000600 16 17 14 8 0 8

*¹ The analog inputs can also be used as digital inputs.

*² The PWM isolated outputs can also be used as digital isolated outputs. The associated PWM

and analog outputs cannot be used at the same time (check switch configuration).
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5 Serigraphy

5.1 A Zone connection (Communications)

Base

A Zone

M-Duino
Connector

Arduino
Pin

Function

AREF
SQW
IOREF
3.3Vdc
5Vdc
GND

AREF
SQW
IOREF
3.3Vdc
5Vdc
GND

Arduino Pin
Arduino Pin
Arduino Pin
Arduino Pin

-
GND

Base

A Zone

M-Duino
Connector

Arduino
Pin

Function

SCL
SDA
RX0
TX0
-
-
TX
RX
Z-
Y+
B-
A+

PIN3
50 SO
51 SI
52 SCK
Reset
Vin5
-

GND
GND
24Vdc

21
20
0
1
-
-
16
17
-
-
-
-
3
50
51
52

Reset
Vin5
-
-
-

I2C/SS
I2C/SS
RX0/SS
TX0/SS

-
-

RX2(serial 2)
TX2(serial 2)

RS485
RS485
RS485
RS485

Arduino Pin
SPI
SPI
SPI
SPI
5V
-

Gnd
Gnd

Power Supply
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SS: Chip Select pins. These pins can act as TTL, so they can work for the Chip Select pin of any

device.

Ethernet Reset USB-B

RTC Programmable button
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5.2 Analog/Digital Zone connection (I/Os)

X Zone

M-Duino
Connector

Function

IX.12
IX.11
IX.10
IX.9
IX.8
IX.7

(-)IX.6
IX.6/INT2

(-)IX.5
IX.5/INT3

(-)IX.4
IX.4

(-)IX.3
IX.3

(-)IX.2
IX.2

(-)IX.1
IX.1

(-)IX.0
IX.0

Analog/Digital In*
Analog/Digital In*
Analog/Digital In
Analog/Digital In
Analog/Digital In
Analog/Digital In

GND IX.6
Interrupt X In**

GND IX.5
Interrupt X In**

GND IX.4
Digital Input*

GND IX.3
Digital Input
GND IX.2

Digital Input
GND IX.1

Digital Input
GND IX.0

Digital Input

*Connectors IX.12, IX.11 and IX.4 are not connected (NC) in D
Zone.
**Connectors IX.6 and IX.5 are not connected (NC) in C Zone and
connector IX.5 is not connected (NC) in B Zone.

2 See section 5.4 to know more about interrupt pins.
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Top Zone

Led indicator I/Os state

X Zone

M-Duino
Connector

Function

GND
AX.7
AX.6
AX.5
QVdc
COM(-)
QX.7
QX.6
QX.5
QX.4
QX.3
QX.2
QX.1
QX.0

GND
Analog Out*
Analog Out
Analog Out

External Isolated Out Vdc
External Isolated Out GND

Digital/PWM Out*
Digital/PWM Out
Digital/PWM Out

Digital Out*
Digital Out
Digital Out
Digital Out
Digital Out

*Connectors AX.7, QX.7 and QX.4 are not connected (NC) in D Zone.

5.3 Relay Zone connection (I/Os)

X Zone

M-Duino
Connector

Function

RX.8
RX.7
RX.6
RX.5
RX.4
AX.2
AX.1
AX.0
GND
QX.2
QX.1
QX.0

COM(-)
QVdc

Relay Out
Relay Out
Relay Out
Relay Out*
Relay Out

Analog Out*
Analog Out
Analog Out

GND
Digital/PWM Out*
Digital/PWM Out
Digital/PWM Out

External Isolated Out Gnd
External Isolated Out Vdc

*Connectors RX.5, AX.2 and QX.2 are not connected (NC) in D Zone.

24



Rev. 5: 26-09-2024

Top Zone

Led indicator I/Os state

X Zone

M-Duino Connector Function

RX.3
RX.2
RX.1
GND
IX.5
IX.4
IX.3
IX.2

IX.1/INT3

(-)IX.1
IX.0/INT
(-)IX.0

Relay Out
Relay Out
Relay Out

GND
Analog/Digital Input
Analog/Digital Input
Analog/Digital Input
Analog/Digital Input

Interrupt X In**
GND IX.1

Interrupt X In*/**
GND IX.0

*Connector IX.0 is not connected (NC) in B Zone.
**Connectors IX.1 and IX.0 are not connected (NC) in C Zone.

5.4 Interrupt equivalence table

See the Reference Table in order to know the specific device details.

Analog/Digital Relay

Zone PLC Input
PLC

Interrupt
M-Duino Pin PLC Input PLC Interrupt M-Duino Pin

B
0.6 INT1 PIN3 0.1 INT2 PIN3

- - - - - -

C
- - - - - -

- - - - - -

D
2.5 INT3 PIN21 2.1 INT1 PIN21

2.6 INT2 PIN20 2.0 INT0 PIN20

Check this link for more information.

3 See section 5.4 to know more about interrupt pins.
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6 Software interface

Industrial Shields PLC are programmed using Arduino IDE, which is a software based on the C

language. They can also be programmed directly using C, but it is much easier working with

Arduino IDE, as it provides lots of useful libraries.

Industrial Shields provide a boards package for programming the PLCs, making it easier and

friendlier. It includes various facilities such as not having to define the pins, etc.

In order to install Industrial Shields boards, these are the steps that must be followed.

Requirements:

Arduino IDE 1.8.15 or above (recommended: 1.8.19).

Steps:

1. Open Arduino IDE and go to: “File -> Preferences” located in the top left corner.
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2. In Additional Boards Manager URLs write the following:

http://apps.industrialshields.com/main/arduino/boards/package_industrialshields_index.json

3. Press OK to save the changes.

4. Go to: Tools -> Board:… -> Boards Manager

5. Search for “industrialshields” on the browser.
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6. Click install (selecting the latest version).

Following these steps you will be able to see now the Industrial Shields Boards:

Once it is selected M-Duino GPRS Family, an extra option will appear on Tools:

There, it can be selected the exact model for every family.

Also there are some examples of programming in File -> Examples -> Examples for M-Duino

GPRS family.

Furthermore there are some extra libraries that can be found in Industrial Shields github.

https://github.com/Industrial-Shields/
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7 How to connect PLC Arduino to PC

- Connect USB port from PLC to PC.

NOTE:
M-Duino GPRS Family uses B-USB cable.

- Open Arduino IDE interface:

- Select Industrial Shields boards -> M-Duino GPRS Family

- Select the correct M-Duino Board (M-Duino 19R+ GPRS in our example).

- Select the correct port.
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8 How to connect PLC to power supply

- M-Duino GPRS Family PLCs are 12-24Vdc supplied. IMPORTANT: The polarity IS NOT

REVERSIBLE!

- Make sure that the live and GND connector of the power supply match the PLC.

- Make sure that the power supply mains output is not higher than 24Vdc.

- Suggested power suppliers

Compact DIN rail power supply. Assembled on 35mm DIN Rail:

-12Vdc / 24Vdc

-2.5A

-30W

Industrial Shields power supplies provide parallel operation, overvoltage protection, and

overcurrent protection. There is a LED inductor for power status, the power supply is

certified according to UL.

The standard, Part 1 of IEC 61010, sets the general safety requirements for the following types

of electrical devices and their accessories, regardless of where use of the device is intended.

The equipment must be powered from an external power source in accordance with IEC

61010-1, whose output is MBTS and is limited in power according to section 9.4 of IEC 61010-1.

WARNING: Once the equipment is installed inside an electrical cabinet, the MTBS cables of the

equipment must be separated from the dangerous voltage cables.
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9 Switch configuration

9.1 A Zone: Communications

A Zone

Switch OFF ON

SCL | XX SCL XX

SDA | XX SDA XX

GPRS | - GPRS -

GPRS| - GPRS -

Pin 3 | XX Pin 3 XX

GPRS RST | - GPRS RST -

SD | - SD -

FD | HD FD HD

This is a Switch example from the M-Duino 57R+ GPRS. In this

case, SCL, SDA, I0.1, SD and HD are enabled. This means I2.1, I2.0,

Pin3 and FD are disabled.

4. SCL | XX: Choosing between SCL or the input XX. If the switch is ON, it enables XX and

disables SCL. If the switch is OFF, it enables SCL and disables XX. The serigraphy in the PLC will

indicate which input is referred to XX.

3. SDA | XX: Choosing between SDA or the input XX. If the switch is ON, it enables XX and

disables SDA. If the switch is OFF, it enables SDA and disables XX. The serigraphy in the PLC will

indicate which input is referred to XX.

2. GPRS | - : Always at OFF position.

1. GPRS | - : Always at OFF position.
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4. Pin 3 | XX: Choosing between Pin 3 or the input XX. If the switch is ON, it enables XX and

disables Pin 3. If the switch is OFF, it enables Pin 3 and disables XX. The serigraphy in the PLC

will indicate which input is referred to XX.

3. GPRS RST | - : Always at OFF position.

2. SD | - : Always at OFF position.

1. FD | HD: Choosing between FD or HD. If the switch is ON, it enables HD and disables FD. If

the switch is OFF, it enables FD and disables HD. Note: HD stands for Half Duplex and FD means

Full Duplex. Check section 11.2 for more information.

A Zone

Switch OFF ON

NC - -

NC - -

NC | RTC - RTC

NC | RTC - RTC

This switch enables the communication with RTC using I2C. Having both switches in ON mode

activates the communication, whereas if they are in OFF mode I2C is disabled to reach the RTC.
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9.2 Digital/Analogic Shield Switches

Digital/ Analogic Shield Switch

Switch OFF ON

NC - -

AX.7 | QX.7 AX.7 QX.7

AX.6 | QX.6 AX.6 QX.6

AX.5 | QX.5 AX.5 QX.5

*X can change depending on which zone we are in. Check the serigraphy in the PLC to know

what number takes X.

We can see here an example switch from the C Zone

(Notice that X takes value 1 here).

For the Analog Shield if a switch is set to ON, it can only act as Digital Output. If it is set to OFF

it can only act as an Analog Output.

If it is desired to use a Digital Output the switch must be set to ON and the pin that will provide

this digital output is represented with QX.X, being X any number of the table above.

If it is desired to use an Analog Output the switch must be set to OFF and the pin that will

provide this digital output is represented with AX.X, being X any number of the table above.

*IMPORTANT: In D Zone, output A2.7 | Q2.7 is not connected.
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9.3 Relay Shield Switches

Relay Shield Switch

Switch OFF ON

NC - -

AX.2 | QX.2 AX.2 QX.2

AX.1 | QX.1 AX.1 QX.1

AX.0 | QX.0 AX.0 QX.0

*X can change depending on which zone we are in. Check the serigraphy in the PLC to know

what number takes X.

We can see here an example switch from the B Zone (Notice

that X takes value 0 here).

For the Relay Shield if a switch is set to ON, it can only act as Digital Output. If it is set to OFF it

can only act as an Analog Output.

If it is desired to use a Digital Output the switch must be set to ON and the pin that will provide

this digital output is represented with QX.X, being X any number of the tables above.

If it is desired to use an Analog Output the switch must be set to OFF and the pin that will

provide this digital output is represented with AX.X, being X any number of the tables above.

*IMPORTANT: In D Zone, output A2.2 | Q2.2 is not connected.
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10 M-Duino Arduino I/Os 5V pins

The M-Duino has some of the Mega board pins available. These pins can be programmed

according to Arduino features such as I/Os operating at 5V or any additional features present in

the pins (for example I2C communication in pins SCL and SDA). As these pins are directly

connected to the Arduino Mega board they are not as well protected as the normal inputs.

These pins are mainly meant to be used as prototyping.

The Arduino board available pins are summarised in the table below. In order to access some of

these pins the configuration switch must be set to OFF position (see section 9) and some extra

considerations must be taken in consideration when using these pins.

M-Duino terminal Arduino pin Enable Arduino pin
SCL 21 Communication switch: OFF
SDA 20 Communication switch OFF
RX0 0
TX0 1

RX (RS232) 17
TX (RS232) 16

MISO 50
MOSI 51
SCK 52
Pin 3 3 Communication switch: OFF

*IMPORTANT: Do not connect the terminals in the chart above to voltages higher than

5V. These terminals provide direct access to the Mega board.

Apart from the switch configuration there are some special conditions depending on these 5V.

Now it is going to be shown the considerations to operate with these pins.

10.1 I2C pins – SDA/SCL

The I2C protocol is meant to work in a pull-up configuration. A pull-up configuration means

that when the pin is at rest (nothing connected to it) it always reads a HIGH value. In this case it

reads 5V when nothing is connected. The pull-up configuration is established by default in

these pins.

In order to use them as an internal arduino direct PIN at 5V, it has to be considered that they

are pull-up inputs (a 2200Ω resistor is used in the internal pull-up).
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10.2 Serial 0 – RX0/TX0

The Serial0 protocol can work also as a 5V pin. These pins should be used ultimately, only in

case that all the 5V pins are already performing a function. This is because they are shared with

the USB interface. If using these pins, the USB communication cannot be working at the same

time.

When the PLC is not installed, the USB communication is normally required for debugging,

uploading and intercommunicating with the Ethernet controller. If using both interfaces at the

same time the Arduino board will get blocked.

These pins are not established with a pull-up or a pull-down configuration. The state of these

pins is unknown. If these pins must be used, they require a pull-up or a pull-down

configuration. The Arduino board allows the pins to be set in a pull-up configuration. If not it

must be established as an external pull-up or pull-down circuit in order to correctly work with

these pins.

10.3 SPI – MISO/MOSI/SCK

These pins can only work as 5V pins if the Ethernet protocol is not going to be used. As the

Ethernet protocol uses the SPI to communicate with the Arduino board, both behaviours

cannot happen at the same time as the Ethernet would not work.

These pins are not established with a pull-up or a pull-down configuration. The state of these

pins is unknown. If these pins must be used, they require a pull-up or a pull-down

configuration. The Arduino board allows the pins to be set in a pull-up configuration. If not it

must be established as an external pull-up or pull-down circuit in order to correctly work with

these pins.

10.4 Pin 3

To know how to configure this pin correctly, check section 9.

This pin is not established with a pull-up or a pull-down configuration. The state of the pin is

unknown. If the pin must be used, it requires a pull-up or a pull-down configuration. The

Arduino board allows the pin to be set in a pull-up configuration. If not it must be established

as an external pull-up or pull-down circuit in order to correctly work with this pin.
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11 A Zone Features: Communications & RTC & uSD

11.1 RS-232

The Arduino Mega function code to access the RS-232 port in the M-Duino is Serial2 (pins 16

and 17 of the Arduino Mega).

For the RS-232 communication protocol there isn’t any switch that affects it. So it does not

matter the configuration of the switches to implement a RS-232 communication.

Using the boards of Industrial Shields, there is a library that simplifies the RS-232

implementation.

Click here4 or here5 to see more about this communication.

11.2 RS-485

For RS485 communication protocol the defined Arduino Mega pins are shown in the chart

below.

Function Arduino Pin
DI 14
RO 15
RE 11
DE 46

For the RS-485 communication protocol there is only one switch that affects this

communication. The RS-485 protocol will be always enabled, the only switch that affects is the

one called “FD rs-485 HD” (See Section 9). This switch makes the choice between RS-485 Half

Duplex or RS-485 Full Duplex (RS-422).

Using the boards of Industrial Shields, there is a library that simplifies the RS-485

implementation.

Click here6 or here7 to see more about this communication.

7
https://www.industrialshields.com/blog/arduino-industrial-1/post/how-to-connect-two-industrial-plcs-through-rs-485-213

6
https://www.industrialshields.com/blog/arduino-industrial-1/post/basics-about-rs-485-of-an-industrial-plc-195

5
https://www.industrialshields.com/blog/arduino-industrial-1/post/how-to-use-rs-232-on-industrial-arduino-based-plc-16

4
https://www.industrialshields.com/blog/arduino-industrial-1/post/basics-about-rs232-of-an-industrial-plc-183
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11.3 I2C

I2C communication DOES NOT REQUIRE a pull-up resistor for the M-Duino. The pull-up resistor

is already implemented in the PCB.

I2C communication is configured by switches, so the switches must be configured in order to

enable the I2C communication (See section 9 for more information).

Industrial Shields does not provide any library to implement the I2C as it can be used with the

standard library of Arduino called Wire.

Click here8 to see more about this communication.

11.4 SPI

The M-Duino pins used for the SPI bus are summarised in the table below. For SPI bus MISO,

MOSI and CLOCK pins are common to all the connected devices to the M-Duino, conversely,

each of the connected devices will have a single and dedicated SS pin.

Function M-Duino connection Mega board pin
MISO 50 S0 50
MOSI 51 SI 51
CLOCK 52 SCK 52
Reset Reset Reset
SS SCL/SDA/RX0/TX0/RX/TX/Pin3 21/20/1/0/16/17/3

Check the switch configuration at section 9 to enable SS pins.

Click here9 to see more about this communication.

11.5 TTL

M-Duino has two TTL ports, RX0/TX0 and RX/TX. TTL0 is accessed with the function Serial (pins

0 and 1 of the Arduino Mega) and TTL2 is accessed with the function Serial2 (pins 16 and 17 of

the Arduino Mega). See section 9 for more information.

11.6 Ethernet

M-Duino Ethernet port controller is based on w5500 IC, which is the IC compatible with

Arduino Ethernet2 Shield libraries. All Ethernet shield Arduino libraries are compatible with the

M-Duino. In the M-Duino, W5500 IC communicates to the Mega board via SPI bus (SS Arduino

Mega pin 10).

Click here10 and here11 to see more about this communication.

11
https://www.industrialshields.com/blog/arduino-industrial-1/post/how-to-use-modbus-tcp-slave-library-with-a-plc-controller-arduino-105

10
https://www.industrialshields.com/blog/arduino-industrial-1/post/modbus-tcp-master-with-industrial-arduino-esp32-plcs-103

9
https://www.industrialshields.com/blog/arduino-industrial-1/post/bus-spi-on-plc-arduino-from-industrial-shields-191

8
https://www.industrialshields.com/blog/arduino-industrial-1/post/i2c-bus-on-plc-arduino-for-industrial-automation-192
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11.7 GPRS & GSM

The SIM800L module is the integrated module for the use of GPRS / GSM in this PLC. Its

principal features are:

● Quad-band 850/900/1800/1900MHz.

● Work only with 2G technology.

● Can send / receive SMS messages.

● Can send / receive GPRS data (TCP/IP, HTTP, MQTT).

● Controlled by AT Commands (3GPP TS 27.0077, 27.005 and SIMCOM enhanced AT

Commands).

● AT Command interface with transmission speed “automatic” detection.

● Max. transmission speed: 85.6 Kbps.

● Serial transmission speed: 1200 bps up to 115200 bps (baud rate).

● SIM size: Micro SIM.

When defining the pins in the program, take into account that the internal connections

between the SIM800L module and the Arduino Leonardo are the following:

Arduino Mega Pinout SIM800L Pinout

5Vdc Vcc

GND GND

Rx1 (Pin 19) TxD

Tx1 (Pin 18) RxD

Pin 2 GPRS RESET

The GPRS / GSM protocol is always enabled as there are no switches that configure it. The

protocol uses the Serial 1 pins of the equipment to be able to communicate and the Pin 2 for

the module reset.
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11.8 RTC

M-Duino RTC Module is based on the DS1307 Chip. This chip works with the I2C protocol

communication, so it is required to have enabled the I2C protocol. This means 4 switches have

to be configured in order to enable the RTC features.

RTC SCL & RTC SDA must be set to ON mode to enable the I2C wires to the RTC. If they are in

OFF mode, the Arduino won’t communicate with the RTC. Look at section 11.3 for more

information.

Using the boards package of Industrial Shields, there is a library that simplifies the RTC

implementation called RTC.

Click here12 to see more about this feature.

11.9 uSD

The micro SD uses the SPI communication to interact with the Arduino Mega. The SPI protocol

is always enabled, as there are no switches that configure it. However, there is a switch that

must be placed to ON mode in order to communicate with the uSD:

SD: If this Switch is OFF, it enables the Chip Select of the microSD socket. If the switch is in ON

mode the microSD can’t be used. Check section 9 for more information.

The uSD socket is found in the TOP part of the communication Shields, so in the frontal part of

the PLC, it is required to open the plastic found in the frontal part and the socket is located

under the supply of the Arduino.

Using the boards of Industrial Shields, there is a library that simplifies the uSD implementation

called SD. It is the same as the Arduino library, with the only modification of using the pin 53 to

select the Chip Select of the uSD chip.

Click here13 to see more about this feature.

13
https://www.industrialshields.com/blog/arduino-industrial-1/post/basics-with-sd-card-in-an-industrial-plc-167

12
https://www.industrialshields.com/blog/arduino-industrial-1/post/rtc-test-on-m-duino-plus-version-51
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Verify that the CPU is not actively running a process before inserting the memory card.

Inserting a memory card will cause the CPU to go to STOP mode, which could affect the

operation of an online process or machine. Unexpected operation of a process or machine

could result in death or injury to personnel and/or property damage. Before inserting a

memory card, always ensure that the CPU is offline and in a safe state.

Vérifiez que le processeur n'exécute pas activement un processus avant d'insérer la

carte mémoire.

Si vous insérez une carte mémoire, la CPU passe en mode STOP, ce qui peut affecter le

fonctionnement d'un processus ou d'une machine en ligne. Le fonctionnement inattendu d'un

processus ou d'une machine peut entraîner la mort ou des blessures corporelles et / ou des

dégâts matériels. Avant d'insérer une carte mémoire, assurez-vous toujours que la CPU est hors

ligne et en sécurité.

41



Rev. 5: 26-09-2024

12 GPRS & GSM Programming Examples

12.1How to use the GPRS Module

By following the steps on this blog14, you will learn how to work with the GPRS Module that is

inside the PLC. A brief explanation about the examples provided by the Industrial Shields

libraries from GPRS is done.

12.2How to send SMS using GPRS from an M-Duino

Two blogs about how SMSs can be sent using GPRS have been written. The first one talks about

sending SMS when a temperature sensor reaches a certain threshold. You can find the blog

here15.

The second one is about general features of the GPRS module and describes an example from

Adafruit FONA libraries. Click this link16 to go to the blog.

16

https://www.industrialshields.com/blog/arduino-industrial-1/post/how-to-send-sms-by-using-plc-contro
ller-arduino-296

15

https://www.industrialshields.com/blog/arduino-industrial-1/post/how-to-send-sms-using-gprs-from-an
-mduino-403

14 https://www.industrialshields.com/blog/arduino-industrial-1/post/how-to-use-gprs-module-158
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13 Instructions for interconnection between Industrial

Shields controllers

13.1 RS-232 Communication:

13.2 RS-485 Communication:

13.2.1 Half Duplex
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13.2.2 Full Duplex

13.3 Ethernet

For Ethernet communication between Industrial Shields equipment an SFTP CAT-6 Ethernet

crossover cable must be used.

14 Digital inputs threshold detection

The M-Duino inputs have a minimum voltage threshold to reliably detect the signal when used

as digital input. The threshold value is different depending on the input type:

44

Input type Threshold voltage (V)

Digital input 4

Analog input 5.1
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15 I/O technical details:

A comparison between the waveforms of the I/Os from the M-Duino GPRS Family PLC and the

Arduino Mega is done in this section.

Digital Output Waveform:

Digital Output Turn-off:

PWM Waveform:
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Analog Out Turn-On:

Analog Out Turn-Off:

Analog /Digital input Turn-on:
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16 Typical Connections
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17 Connector details

The connector inside the PLCs that mounts on the PCB is MC 0,5/10-G-2,5 - 188152917

connector from Phoenix contact.

In the PLC we can find other connectors too, and these are the references for them:

MC 0,5/ 4-G-2,5 - 1881464

MC 0,5/ 6-G-2,5 - 1881480

MC 0,5/ 9-G-2,5 - 1881516

Connection details (10 pins):

Article reference MC 0,5/10-G-2,5 - 1881529

Height 8.1 mm

Pitch 2.5 mm

Dimension 22.5 mm

Pin dimensions 0.8 x 0.8 mm

Pin spacing 2.5 mm

17 https://www.phoenixcontact.com/en-us/products/pcb-header-mc-0510-g-25-1881529

52

https://www.phoenixcontact.com/en-us/products/pcb-header-mc-0510-g-25-1881529


Rev. 5: 26-09-2024

For I/O and power supply there is a FK-MC 0,5/10-ST-2,5 - 188140618 connector from Phoenix

contact.

In the PLC we can find other connectors too, and these are the references for them:

FK-MC 0,5/ 4-ST-2,5 - 1881341

FK-MC 0,5/ 6-ST-2,5 - 1881367

FK-MC 0,5/ 9-ST-2,5 - 1881396

Connection details (10 pins):

Article reference FK-MC 0,5/10-ST-2,5

Rigid conduit section min. 0,14 mm²

Rigid conduit section max. 0,5 mm²

Flexible conduit section min. 0,14 mm²

Flexible conduit section max. 0,5 mm²

Conduit section AWG/kcmil min. 26

Conduit section AWG/kcmil max. 20

We can also find the relay connectors.

18

https://es.farnell.com/phoenix-contact/fk-mc-0-5-10-st-2-5/plug-libre-muelle-2-5-mm-10-v/dp/1792814
?CMP=KNC-GES-GEN-KWL-PDP-High-Aov-phoenix-contact-15-July-22&mckv=_dc%7Cpcrid%7C60387320
4419%7C&gclid=Cj0KCQjw_viWBhD8ARIsAH1mCd4jIzLvIJs5K_3lEpaW5Anqo3FBLu1TwiPFtyKaiP-rj4LSIy6
7bWoaAuLnEALw_wcB
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MCV 1,5/ 2-G-3,81 180342619 is the female connector, and MC 1,5/ 2-ST-3,81, GTIN UPC20 is the

male one. Both are from Phoenix Contact.

Article reference MCV 1,5/ 2-G-3,81 1803426

Height 12.6 mm

Pitch 3.81 mm

Dimension a 3.81 mm

Pin dimensions 0.8 x 0.8 mm

Article reference MC 1,5/ 2-ST-3,81 - 1803578

Height 11.1 mm

Pitch 3.81 mm

Dimension a 3.81 mm

20

https://es.farnell.com/phoenix-contact/1803578/terminal-block-pluggable-2pos/dp/3704907?gclid=Cj0K
CQjw_viWBhD8ARIsAH1mCd6YjA37NqmaaFBXgbRyGExfAM8qDodVOWZPfYsLLQhnVygDn8ufNsIaAmgYE
ALw_wcB&mckv=_dc%7Cpcrid%7C575710444791%7Cplid%7C%7Ckword%7C%7Cmatch%7C%7Cslid%7C
%7Cproduct%7C3704907%7Cpgrid%7C131987845643%7Cptaid%7Cpla-372506228807&CMP=KNC-GES-
GEN-SMART-SHOPPING-High-Jan-2022&gross_price=true

19

https://www.tme.eu/es/details/mcv1.5_2-g-3.81/bloque-de-bornas-extraibles/phoenix-contact/mcv-1-5
-2-g-3-81-1803426/?brutto=1&currency=EUR&gclid=Cj0KCQjw_viWBhD8ARIsAH1mCd763F0sGBmfjy5p
mZm9dKysA6ePciWt8md8utGsZX1OfLpgsBx4mnoaAo9GEALw_wcB
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18 DIN Rail mounting

For optimal operation of the product, it must be located in an electrical cabinet with
IK08 mechanical protection. The minimum IP protection degree required is IP56.
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19 Installation and Maintenance

Notes for installation:

- The installation position should be free from the following: dust or oil smoke,
conductive dust, corrosive or flammable gas, high temperature, condensation, and
rain.

- Besides, vibration and impact also affect the PLC normal operation and shorten its
lifespan; electric shock, fire or misact also damages the product. During drilling or
wiring, prevent the metal particles or wire segments from falling into the PLC casing,
which may cause fire, fault or misact.

- After the PLC installation, clean the ventilation duct to prevent blocking, which may
cause bad ventilation, or even fire, faults or misact.

- Do not online connect, plug or unplug cables, which are apt to cause electric shock or
damage the circuit. Installation and wire connection must be firm and reliable. Poor
connection could cause misact.

- Use shielded twisted pair for the I/O of high frequency signal and analog signal to
improve system IMS.

The installation environment should be free from dust, oil smoke, conductive particles,
corrosive or flammable gases, high temperature, condensation, and rain.

Besides, vibration and impact also affect the PLC normal operation and shorten its lifespan.
It is recommended to install the PLC, together with the matching switches and contactors,
in a dedicated electric cabinet and keep the cabinet ventilated. If the location has high
ambient temperature or heat generating equipment nearby, install forced convection
devices on top or sides of the cabinet to avoid over-temperature. During drilling or wiring,
prevent the metal particles or wire segments from falling into the PLC casing, which may
cause fire, fault or misact. After the PLC installation, clean the ventilation duct to prevent
blocking, which may cause bad ventilation, or even fire, faults or misact.

The only way to disconnect the equipment from the electrical network is by removing the
connectors that feed the equipment. Once installed in the electrical cabinet it is very
important to ensure the power connectors for proper operation.

Separate the M-Duino Family PLC from heat, high voltage and electrical noise:

Always separate the devices that generate high voltage and high electrical noise from the
M-Duino. When configuring the layout of the M-Duino inside your panel, consider the
heat-generating devices and locate the electronic-type devices in the cooler areas of your
cabinet. Reducing the exposure to a high-temperature environment will extend the
operating life of any electronic device. Consider also the routing of the wiring for the
devices in the electric cabinet. Avoid placing low-voltage signal wires and communications
cables in the same tray with AC power wiring and high energy, rapidly-switched DC wiring.

Provide adequate clearance for cooling and wiring M-Duino. Is designed for natural
convection cooling. For proper cooling, you must provide a clearance of at least 25 cm
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above and below the devices. Also, allow at least 25 cm of depth between the front of the
modules and the inside of the enclosure.

Notes for maintenance:

A well-planned and executed maintenance program is essential to the satisfactory operation of
solid-state electrical equipment. The kind and frequency of the maintenance operation will
vary with the kind and complexity of the equipment as well as with the nature of the operating
conditions. Maintenance recommendations of the manufacturer or appropriate product
standards should be followed.

The following factors should be considered when formulating a maintenance program:

- Maintenance must be performed by qualified personnel familiar with the construction,
operation, and hazards involved with the control.

- Maintenance should be performed with the control out of operation and disconnected
from all sources of power.

- Care should be taken when servicing electrostatic sensitive components. The
manufacturer's recommendations for these components should be followed.

- Ventilation passages should be kept open. If the equipment depends upon auxiliary
cooling, e.g., air, water, or oil, periodic inspection (with filter replacement when
necessary) should be made of these systems.

- The means employed for grounding or insulating the equipment from ground should
be checked to assure its integrity.

- Accumulations of dust and dirt on all parts, including on semiconductor heat sinks,
should be removed according to the manufacturer's instructions, if provided;
otherwise, the manufacturer should be consulted. Care must be taken to avoid
damaging any delicate components and to avoid displacing dust, dirt, or debris in a way
that permits it to enter or settle into parts of the control equipment.

- Enclosures should be inspected for evidence of deterioration. Accumulated dust and
dirt should be removed from the top of the enclosures before opening doors or
removing covers.

- Certain hazardous materials removed as part of maintenance or repair procedure (e.g.,
polychlorinated biphenyls (PCBs) found in some liquidfilled capacitors) must be
disposed of as described in Federal regulations.

Safety rules for maintenance personnel

Consider the following steps to follow. A false manoeuvre could be the cause of an
accident or material damage.
Do not disassemble or modify the modules. This could lead to breakdowns or
malfunctions and could lead to injuries or fire.

- All types of radio communication devices, including mobile phones and personal
handy-phone systems (PHS), must be kept more than 25cm away from the PLC in all
directions. Failure to observe this precaution exposes malfunctions caused by an excess
of temperature.
- Disconnect the external power supply of the system (on all phases) before connecting
or disconnecting a module. Failure to observe this precaution may cause faults or
malfunctions of the module.
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- Tighten the screws of the terminal ports and the screws of the connectors within the
prescribed tightening torque. Insufficient tightening can lead to loose parts or wires
and cause malfunctions. Excessive tightening can damage the screws and / or the
module, with the risk of falling, short circuits and malfunctions.
- Before handling a module, dispose of the electrostatic charge accumulated by the
human body by touching a suitable conductive object. Failure to observe this
precaution may cause faults or malfunctions of the module.

Repair note:

If the equipment is suitable to be repaired, it must be verified that the equipment
remains in a safe state after repair.
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20 Revision Table

Revision Number Date Changes

0 29/08/2019 First implementation

1 02/03/2020 Second implementation

2 23/11/2020 Third implementation

3 30/09/2022 M-Duino GPRS Family User Manual Implementation

4 11/03/2024 Added section 14 “Digital inputs threshold detection”

5 26/09/2024 Added section 3.4 (“Isolation Precautions”)

About Industrial Shields:

Direction: Camí del Grau, nº25

Zip/Postal Code: 08272

City: Sant Fruitós de Bages (Barcelona)

Country: Spain

Telephone: (+34) 938 760 191 / (+34) 635 693 611

Mail: industrialshields@industrialshields.com
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